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POWER BI QUESTIONS (ADVANCED FINANCIAL 
REPORTING) 

Question 1 

Ultra-Low Cost Ltd. (ULC) is a public company located in Vancouver and prepares its 
financial statements in accordance with IFRS. Its year end is December 31. With the 
cost of living increasing in Vancouver, it has found success supplying low cost stores 
with merchandise sourced from other countries.  

ULC was founded five years ago by Jan and Colton, a couple who noticed their monthly 
budget was increasing steadily even though they were not purchasing anything out of 
the ordinary. Jan had an idea that if quality everyday purchases could be sourced from 
elsewhere and provided to low cost stores in Vancouver, it would present an affordable 
way for other Vancouverites to continue to afford to live in the city.  

ULC has never formally tracked its foreign purchases before. However, over the last 
three years ULC has sourced much more goods from foreign countries and would like to 
understand where the purchases are coming from so that a hedging strategy can be 
adopted.   

To reduce shipping costs and earn discounts for bulk buys, ULC only purchases foreign 
goods once a year in each country that it deals with. It placed all orders on December 
15, 20X8 and took delivery of all inventory on January 15, 20X9.   

Use Power BI to provide an analysis of the transactions so Jan and Colton can 
understand their foreign currency transactions. 

Required: 

a) Prepare the following: 
i. Create a card visualization of how many countries ULC does business with. 
ii. Create a card visualization of how many different currencies ULC conducts 

business in. 
iii. Create a map visualization of the supplier locations. 
iv. Create a pie chart showing how much of cost of goods sold (in Canadian dollars) 

is spent in each currency. 
v. Create a table showing the foreign exchange rates in effect on the day the order 

was placed (the spot rate) and the day the order was paid for (the settlement 
rate). 
 

Hint: Your visualization must be selected before you can work on it. To select your 
visualization, simply click on it in Power BI. 
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Power BI Instructions for Question 1 

For each of the visualizations required, paste a picture of your final visualization into 
your assignment submission file.  

NOTES: 
ULC tracks the following information about its vendors and purchases: 

• Region: Global geographic region (defaults to North America) 

• Country: Country of product origin. 

• Currency: Currency used in the Country 

• Spot Rate: The foreign exchange rate in place on the day the order was placed 

• Settlement Rate: The foreign exchange rate in place on the day the order was paid 
for. 

• Order Date: Date the order was purchased 

• Order ID: Unique Identifier for each item purchased 

• Settlement Date: Date the order was paid for 

• Units Purchased: Number of units purchased per Order ID. 

• Unit Cost: The unit cost of each item (reported in Canadian dollars). 
• Total Cost: Total cost of the order (Units Purchased x Unit Cost). 
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Appendix I 
Step 1:  

Open Power BI and import your data. 

 
 

1. Select “Get Data” 

2. Select “Excel” and then click 
“Connect.” Locate your 
“Q1_Transaction History” file. 
Select “Open.” 
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3. Select “Sales Records” 

You should see a preview of the 
data that looks similar to this.   

Please note that not all the data in 
the file will appear in the preview 
window. 

4. Select “Load” 

Before you can work with the data, make sure there are no blank rows in the table.   
 

 
 
 

 

1. Select the Data view on 
the left side of your screen. 

2. From the Home tab, 
Select “Transform data”. 
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3. Select the arrow beside Region and 
look for (null). Deselect the box beside 
(null) if it appears as a choice. Then 
click OK. 

4. Select Close & Apply. 

5. Return to the Report view by selecting 
the icon on the left of your screen. 
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Step 2 (Required #1): 

Create a visualization using the card function and the “Country” field to determine how 
many countries that ULC does business with.  

 

 
 

 

1. Choose “Card.” 2. Select “Country.” 

3. Using the dropdown 
arrow next to “First 
Country” in the Fields 
area, change the 
selection from “First” to 
“Count (Distinct).”  This 
will tell you how many 
countries are in ULC’s 
database.  
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Step 3 (Required #2): 

Create a card visualization of how many different currencies ULC conducts business in.   

Hint: To create a new card, click anywhere on your Power BI report “Page.”   Then 
follow the steps below. 

 

1. Choose “Card.” 

2. Select “Currency.” 

3. Using the dropdown 
arrow next to “First 
Currency” in the Fields 
area, change the 
selection from “First” to 
“Count (Distinct).”  This 
will tell you how many 
currencies are in ULC’s 
database.  
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Step 4 (Required #3): 

Create a map visualization of the supplier locations. 

HINT: Click on the  
 

             button on the lower left-hand side of your report page to 
generate a new page on which to create your map. Maps can be sometimes be quite 
large, and it is helpful to put them on their own page.  You can rename each page by 
right clicking on the tab, just as you can in Excel. 

 
 
 

 

1. Choose “Map.” 

2. Select “Country.” 

3. Next, drag “Country” 
from the Fields area to 
the “Legend” area of the 
Visualizations.  This will 
give each country a 
unique colour. 
 
Should you choose, you 
can adjust the 
placement of the legend 
on your visualization in 
the formatting menu.  
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Step 5 (Required #4): 

Create a pie chart showing how much of cost of goods sold (in Canadian dollars) is 
spent in each currency. 

HINT: Click on the               button on the lower left-hand side of your report page to 
generate a new page on which to create your pie chart. Charts may sometimes need to 
be expanded in order to understand the data presented so it is helpful to put them on 
their own page.   

 

1. Choose “Pie Chart.” 

2. Select “Currency.” 

3. Then select “Total Cost.”  
Expand the Visualization so 
that you can easily read all of 
the data on each “slice” of 
the Pie. 

Adjust the presentation of 
legend through the formatting 
menu (“Legend” and “Detail 
labels”). Select “All detail 
labels” in the Label Style 
menu. 
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Step 6 (Required #5): 

Create a table showing the foreign exchange rates in effect on the day the order was 
placed (the spot rate) and the day the order was paid for (the settlement rate). Paste 
your table with all currencies into your assignment. 

ULC wants to focus on the three currencies with the greatest spend, which you have 
been able to identify from your pie chart above. Paste your table with the three highest 
spend currencies into your assignment. 

 

1. Choose “Table.” 

2. Select “Currency.” 

3. Then select “Spot Rate” 
and “Settlement Rate.”  

Be sure to use the dropdown 
menu to select “Average” for 
both rates you are presenting 
in the “Values” field. 

In the “Format” menu, turn 
totals off. 

4. Next, apply a filter to 
your visualization to 
isolate only the three 
currencies with the 
highest volume of 
purchases. 
 
If “Currency” has not 
automatically populated 
as a filterable field, drag 
the “Currency” Field into 
the “Add data fields 
here” box underneath 
the Filters Menu. 
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Question 2 

Nuts and Bolts Inc (NBI) is a public company located in Milton and prepares its financial 
statements in accordance with IFRS. Its year end is December 31. With the increasing 
population in Milton, it has found success supplying hardware stores with inventory 
sourced from other countries.  

NBI was founded five years ago by Peter and Joshua, business partners who used to 
do project management in a construction company together. Joshua had an idea that if 
quality hardware purchases could be sourced from elsewhere and provided to local 
hardware stores in Milton, it would present a way to keep construction costs low for the 
increased population coming to the city.  

NBI has never formally tracked its foreign purchases before. However, over the last 
three years NBI has sourced much more goods from foreign countries and would like to 
understand where the purchases are coming from so that a hedging strategy can be 
adopted.   

To reduce shipping costs and earn discounts for bulk buys, NBI only purchases foreign 
goods once a year in each country that it deals with. It places all orders on December 
15, 20X8 and takes delivery of all inventory on January 15, 20X9.   

Use Power BI to provide an analysis of the transactions so Peter and Joshua can 
understand their foreign currency transactions. 

Required: 

i. Create a card visualization of how many countries NBI does business with. 
ii. Create a card visualization of how many different currencies NBI conducts 

business in. 
iii. Create a map visualization of the supplier locations. 
iv. Create a pie chart showing how much of cost of goods sold (in Canadian dollars) 

is spent in each currency. 
v. Create a table showing the foreign exchange rates in effect on the day the order 

was placed (the Spot rate) and the day the order was paid for (the Settlement 
rate). 
 

NOTES: 
NBI tracks the following information about its vendors and purchases: 

• Region: Global geographic region (defaults to North America) 

• Country: Country of product origin. 

• Currency: Currency used in the Country 

• Spot Rate: The foreign exchange rate in place on the day the order was placed 
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• Settlement Rate: The foreign exchange rate in place on the day the order was paid 
for. 

• Order Date: Date the order was purchased 

• Order ID: Unique Identifier for each item purchased 

• Settlement Date: Date the order was paid for 

• Units Purchased: Number of units purchased per Order ID. 

• Unit Cost: The unit cost of each item (reported in Canadian dollars). 
• Total Cost: Total cost of the order (Units Purchased x Unit Cost). 

 

  



Power BI Questions (Advanced Financial Reporting) 
 

 14 / 40 
 

Appendix I 

Step 1:  

Open Power BI and import your data. 

 

2. Select “Get Data” 

2. Select “Excel” and then click 
“Connect.” Locate your 
“Q2_Transaction History” file. 
Select “Open.” 
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3. Select “Sales Records” 

You should see a preview of the 
data that looks similar to this.   

Please note that not all the data in 
the file will appear in the preview 
window. 

4. Select “Load” 
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Step 2 (Required #1): 

Create a visualization using the card function and the “Country” field to determine how 
many countries that NBI does business with.  

 

 
 

 

1. Choose “Card.” 2. Select “Country.” 

3. Using the dropdown 
arrow next to “First 
Country” in the Fields 
area, change the 
selection from “First” to 
“Count (Distinct).”  This 
will tell you how many 
countries are in NBI’s 
database.  
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Step 3 (Required #2): 

Create a card visualization of how many different currencies NBI conducts business in.   

Hint: To create a new card, click anywhere on your Power BI report “Page.”   Then 
follow the steps below. 

 

1. Choose “Card.” 

2. Select “Currency.” 

3. Using the dropdown 
arrow next to “First 
Currency” in the Fields 
area, change the 
selection from “First” to 
“Count (Distinct).”  This 
will tell you how many 
currencies are in NBI’s 
database.  
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Step 4 (Required #3): 

Create a map visualization of the supplier locations. 

HINT: Click on the   
 

            button on the lower left-hand side of your report page to 
generate a new page on which to create your map. Maps can be sometimes be quite 
large, and it is helpful to put them on their own page.  You can rename each page by 
right clicking on the tab, just as you can in Excel. 

 
 

 
 

1. Choose “Map.” 

2. Select “Country.” 

3. Next, drag “Country” 
from the Fields area to 
the “Legend” area of the 
Visualizations.  This will 
give each country a 
unique colour. 
 
Should you choose, you 
can adjust the 
placement of the legend 
on your visualization of 
the formatting menu.  



Power BI Questions (Advanced Financial Reporting) 
 

 19 / 40 
 

Step 5 (Required #4): 

Create a pie chart showing how much of cost of goods sold (in Canadian dollars) is 
spent in each currency. 

HINT: Click on the               button on the lower left-hand side of your report page to 
generate a new page on which to create your pie chart. Charts may sometimes need to 
be expanded in order to understand the data presented so it is helpful to put them on 
their own page.  You can rename each page by right clicking on the tab, just as you can 
in Excel. 
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1. Choose “Pie Chart.” 

2. Select “Currency.” 

3. Then select “Total Cost.”  
Expand the Visualization so 
that you can easily read all of 
the data on each “slice” of 
the Pie. 

Adjust the presentation of 
legend through the formatting 
menu (“Legend” and “Detail 
labels”). Select “All detail 
labels” in the Label Style 
menu. 
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Step 6 (Required #5): 

Create a table showing the foreign exchange rates in effect on the day the order was 
placed (the spot rate) and the day the order was paid for (the settlement rate). Paste 
your table with all currencies into your assignment. 

NBI wants to focus on the three currencies with the greatest spend, which you have 
been able to identify from your pie chart above. Paste your table with the three highest 
spend currencies into your assignment. 
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1. Choose “Table.” 

2. Select “Currency.” 

3. Then select “Spot Rate” 
and “Settlement Rate.”  

Be sure to use the dropdown 
menu to select “Average” for 
both rates you are presenting 
in the “Values” field. 

In the “Format” menu, turn 
totals off. 

4. Next, apply a filter to 
your visualization to 
isolate only the three 
currencies with the 
highest volume of 
purchases. 
 
If “Currency” has not 
automatically populated 
as a filterable field, drag 
the “Currency” Field into 
the “Add data fields 
here” box underneath 
the Filters Menu. 



Power BI Questions (Advanced Financial Reporting) 
 

 23 / 40 
 

Question 3 

You, CPA, work as an associate with a financial and business advisory firm. Great 
Retrofits Ltd. (GRL), a client of your firm, is a large Canadian company that owns and 
operates across Canada retrofitting older structures and assets to extend their useful 
life.  

You have been asked by the company’s chief financial officer (CFO) to complete a 
special project that will have significant impacts on the future of how GRL measures its 
foreign currency transactions. 

Over the past 3 years, GRL has grown significantly. The amount of U.S. dollar 
purchases being undertaken to obtain the inventory required has also increased, though 
this is not currently being tracked. The CFO has heard that hedging may be a way to 
alleviate exchange rate fluctuations and has asked you to gather information on the 
foreign transactions that have occurred over the past two years, so that the Board of 
Directors can determine if a hedging strategy is needed going forward.  

Required: 

Using Power BI, provide the CFO with the following information on foreign currency 
transactions: 

1. A card visualization which shows the number of U.S. dollar transactions over the 
past two years. 

2. A stacked column chart showing the U.S. dollar transactions compared to CAD 
transactions. 

3. A table showing the dollar value of U.S. dollar transactions compared to CAD 
transactions. 

 
NOTES: 
GRL tracks the following information about its vendors: 
1. Region: Global geographic region (defaults to North America) 
2. Country: Country of product origin. 
3. Fiscal Year: Year of purchase 
4. Order ID: Unique Identifier for each item purchased. 
5. Units Purchased: Number of units purchased per Order ID. 
6. Unit Cost: The unit cost of each item (reported in Canadian dollars). 
7. Total Cost: Total cost of the order (Units Purchased x Unit Cost). 
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Appendix I 
Step 1:  

Open Power BI and import your data. 

 

 

 

1. Select “Get Data” 

2. Select “Excel” and then click 
“Connect.” Locate your 
“Q3_Transaction History” file. 
Select “Open.” 
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3. Select “CAN & US 
Records” 

You should see a preview of the 
data that looks similar to this.   

Please note that not all the data in 
the file will appear in the preview 
window. 

4. Select “Load” 
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Step 2 (Required #1): 

Create a visualization using the card function and the “Country” field to determine how 
many purchases were made using USD.  

 

 

 

  

1. Choose “Card.” 

2. Select “Country.” 

3. Using the dropdown 
arrow next to “First 
Country” in the Fields 
area, change the 
selection from “First” to 
“Count.”  This will tell 
you how many 
transactions there were. 
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4. Next, apply a filter to 
your visualization to 
isolate only USD 
transactions. 
 
Drag the “Country” Field 
into the “Add data fields 
here” box underneath 
the Count of Country 
Filters Menu. 

5. Under Filter type, 
select Basic Filtering. 
 
Next, select “United 
States of America.”   
 
Your card should now 
only display the number 
of USD transactions. 
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Select the format icon and turn title on. Give your visualization a title.  
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Step 3 (Required #2): 

Create a stacked column chart showing the number of USD transactions compared to 
CAD transactions. 

 

1. Choose 
“Stacked Column 
Chart.” 

2. Select “Country.” 
 
This will populate 
the “Axis” field of 
your visualization. 
 
 

3. Next, drag “Country” into the 
“Value” field of your visualization 
and, using the dropdown arrow, 
select “Count.” 
 
This will give you a side by side 
comparison of the number of 
transactions. 
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4. To increase the impact of your 
visualization, you can choose a 
variety of formatting options, located 
on the Visualization Menu. 
 
Try adding a Title to your 
Visualization, and turning Data 
labels on. 
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Step 4 (Required #3): 

Create a table chart showing the dollar value of USD transactions compared to CAD 
transactions. 

 

 

  

1. Choose “Table.” 

2. Select “Country” 
and “Total Cost.”  
This will populate 
the Values fields of 
the Visualization. 
 
 

3. Consider formatting your  table to improve how the 
information is presented, by 
giving it a title or some 
background colour. 
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Solutions 

Solution to Question 1  

Required #1: 

 
Required #2: 
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Required #3: 

 
 

Required #4: 
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Required #5: 

Filtered: 
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Solution to Question 2 

Required #1: 

 
Required #2: 
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Required #3: 
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Required #4: 
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Required #5: 

 
Filtered: 
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Solution to Question 3 

Required #1: 

 

Required #2: 
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Required #3: 
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